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ВСТУП 

Дані методичні рекомендації підготовлені для 
здобувачів вищої освіти першого (бакалаврського) рівня з 
метою якісного опанування вибіркової дисципліни «Системи 
обробки графічних зображень».Мета методичних 
рекомендацій полягає у забезпеченні студентів теоретичними 
положеннями та практичними завданнями, необхідними для 
формування навичок роботи з сучасними графічними 
редакторами, опрацювання растрових та векторних 
зображень, а також розробки графічних композицій і 
цифрових матеріалів. 

Завдання методичних рекомендацій: 
– сприяти закріпленню знань з основ комп’ютерної 

графіки; 
– сформувати практичні навички роботи з 

інструментами редагування графічних об’єктів; 
– розвинути вміння створювати композиції та 

інтегрувати графіку у навчальні та проєктні завдання; 
– підготувати студентів до виконання індивідуальних 

завдань та проєктної роботи. 
Рекомендації можуть бути використані студентами 

різних освітніх програм, що обирають дисципліну як частину 
індивідуальної освітньої траєкторії. 

Дані методичні рекомендації розроблені для студентів, 
які навчаються за спеціальністю 122 «Комп’ютерні науки» 
освітньо професійна програма «Комп’ютерна графіка та 
розробка ігор», для вивчення змістовного модуля 

«Растрова компʼютерна графіка». Зазначена дисципліна 
згідно з освітньою програмою та навчальними планами 



 

підготовки бакалаврів належить до нормативної частини 
циклу дисциплін професійної і практичної підготовки.    

Основним призначенням даного видання є: 
поглиблення теоретичних знань, отриманих студентами під 
час вивчення змістового модуля; набуття практичних навичок 
роботи з растровою компʼютерної графіки.    

Повне виконання лабораторної роботи передбачає 
виконання таких етапів: ознайомлення з теоретичними 
відомостями; аналіз прикладу виконання; аналіз 
індивідуальної теми; формування висновків по роботі; 
оформлення та захист звіту; підготовка до подальших 
контрольних заходів.   

Звіт із лабораторної роботи оформлюється згідно з 
вимогами Державного стандарту України ДСТУ 3008-95   

,,Документація. Звіти у сфері науки і техніки. 
Структура і правила оформлення”, міжнародних стандартів 
ISO 5966:1982, ГОСТ 19.404 ЕСПД ,,Пояснительная записка. 
Требования к содержанию и оформлению” і повинен містити 
такі складові: номер роботи; тема роботи; мета роботи; розділ, 
у якому описано хід виконання роботи відповідно до пунктів 
завдання; висновки; додаток із лістингами HTML та CSS(за 
необхідності). Звіт виконується в електронному вигляді, , 
доповнюється відповідями на контрольні питання і здається 
на кафедру для перевірки та захисту.   

Під час оформлення звіту необхідно дотримуватися 
таких вимог: звіт оформлюється на аркушах формату А4 з 
рамками (перша сторінка – з кутовим штампом форми 2, 
решта сторінок – форми 2а за ГОСТ 2.104-68 ЕСКД. 
,,Основные надписи”). Штампи заповнюються згідно з 
вимогами. Нумерація сторінок наскрізна в межах роботи. 
Поля для тексту: ліве – 25 мм, праве – 10 мм, верхнє – 20 мм 
від краю аркуша, нижнє – 10 мм від верхнього краю штампа. 



Текст роботи оформлюється шрифтом Times New Roman 14-
го розміру, міжрядковий інтервал 1 – 1,5. Абзацний відступ 5 
символів. Ілюстрації та таблиці повинні розміщуватися 
безпосередньо після тексту, де вони зустрічаються.   

Ілюстрації (креслення, рисунки, схеми тощо) 
позначаються таким чином: ,,Рисунок № – Назва рисунка” 
(вирівнювання по центру, без абзацного відступу). 
Позначення ілюстрації виконується під ілюстрацією. Якщо 
кількість ілюстрацій значна і вони однотипні та невеликі за 
розміром, то їх рекомендується групувати в одну ілюстрацію, 
позначати літерами а), б) ... і підписувати їх як одну 
ілюстрацію.    

Таблиці позначаються таким чином: ,,Таблиця № – 
Назва таблиці” (вирівнювання по лівому краю, без абзацного 
відступу). Їх нумерація здійснюється окремо і наскрізно у 
межах роботи. Позначення таблиці виконується над таблицею. 
Текст таблиць рекомендується оформлювати шрифтом New 
Roman 12-го розміру, міжрядковий інтервал 1. Якщо таблиця 
займає понад одну сторінку, то на другій і наступних 
сторінках ставиться позначення ,,Продовження табл. №”. 
Головка таблиці повторюється в усіх її частинах.   

У тексті звіту можна використовувати переліки (списки 
в термінології текстових редакторів). Перед перерахуванням 
ставиться двокрапка. Перед кожною позицією переліку можна 
ставити тире, малу літеру українського алфавіту з дужкою, 
арабські цифри з дужкою. Елементи переліку пишуться з 
маленької літери, наприкінці ставиться крапка з комою, для 
останнього елемента – крапка.   

Важливо, щоб контрольні питання, які наводяться після 
кожної лабораторної роботи, були ретельно відпрацьованими 
студентом самостійно з метою підготовки до контрольних 
заходів, таких як тестування та вирішення практичних 
завдань.   



 

ПРАКТИЧНА РОБОТА №1 

Тема: Види комп'ютерної графіки. Теорія кольору. 
Інструменти виділення.  

Мета: Закріпити навички роботи з інтерфейсом 
графічного редактора, розмірами зображень, інструмен-
тами виділення та шарами, створивши стильний постер 
на тему "Космічний туризм". 

 
Теоретичний матеріал: 
 
https://helpx.adobe.com/ua/photoshop/kb/create-collages-
montages-photoshop-photoshop.html  

 
Завдання 1:  

Підготувати робочу область відповідно ваших потреб: 
-налаштувати одиниці вимірювання; 
-виставити лінійки; 
-налаштувати направляючі; 
-виставити режим інтерфейсу. 
 
Завдання 2: 
Перетворити звичайний портрет людини у стиль 

"кіберпанк" – додавши неонові елементи, механічні імпланти 
та світлові ефекти. 

 
1. Підготовка робочого простору 
Відкрийте Photoshop та створіть документ 1920×1080 px 

або 1080×1350 px (якщо готуєте пост для соцмереж). 
Завантажте або виберіть портрет людини для редагування. 

https://helpx.adobe.com/ua/photoshop/kb/create-collages-montages-photoshop-photoshop.html
https://helpx.adobe.com/ua/photoshop/kb/create-collages-montages-photoshop-photoshop.html


Створіть новий шар для майбутніх ефектів. 
2. Виділення обличчя та деталей 
Використовуйте Quick Selection Tool або Magic Wand 

Tool, щоб виділити обличчя чи певні ділянки (очі, волосся, 
шкіру). 

Якщо потрібно, доопрацюйте виділення Lasso Tool для 
точності. 

Скопіюйте виділену область на новий шар (Ctrl + J). 
3. Додавання кіберпанк-елементів 
Механічні імпланти: Завантажте  текстури металу, схем, 

чипів і розмістіть їх на нових шарах.  
Неонові вставки: Завантажте світлові ефекти, додайте до 

зображення.   
4. Покращення фону 
Додайте місто у стилі кіберпанк, розмиті неонові вогні 

або нічний пейзаж. 
5. Збереження роботи 
Збережіть у форматі PSD для подальших правок. 
Експортуйте у JPEG/PNG для презентації. 
 
Завдання 3:  
Розробити рекламний постер для вигаданої компанії, яка 

пропонує туристичні подорожі в космос. Постер має включати 
фон, головний об'єкт (космічний корабель, планету або астро-
навта), текстовий блок із коротким рекламним слоганом, а та-
кож додаткові графічні елементи для створення атмосфери. 

1. Підготовка робочого простору 
Відкрийте графічний редактор (Adobe Photoshop). 
Створіть новий документ розміром 1080×1350 px. 



 

Оберіть відповідну кольорову схему (темні відтінки кос-
мосу + яскраві акценти). 

2. Додавання фону 
Завантажте або створіть власний фон (зоряне небо, ту-

манність, планети). 
Використовуйте градієнти для створення глибини. 
Додайте фільтри або ефекти (наприклад, "Розмиття" для 

далекого тла). 
3. Робота з головним об'єктом 
Додайте головний елемент (космічний корабель, астро-

навта або планету). 
Використовуйте інструменти виділення (Lasso, Quick 

Selection) для коригування зображення. 
Розмістіть об'єкт так, щоб він був у фокусі (золотий пере-

тин,  правило третин). 
4. Додавання тексту 
Виберіть стильний шрифт (бажано футуристичний). 
Додайте слоган, наприклад: 
"Космос ближче, ніж здається!" 
"Відкрий для себе нові горизонти!" 
"Наступна зупинка — Марс!" 
Використовуйте тінь або світловий ефект для виділення 

тексту. 
5. Додавання додаткових елементів 
Зоряний пил або частинки: Намалюйте або додайте тек-

стуру, щоб зробити атмосферу більш космічною. 
Технічні деталі: Додайте панель управління, контури 

маршрутів, схеми чи індикатори, які натякають на високотех-
нологічність. 



Логотип компанії: Підберіть простий логотип для вига-
даної туристичної фірми та розмістіть його у верхньому чи 
нижньому кутку. 

6. Збереження та експортування 
Перевірте фінальний вигляд. 
Збережіть файл у PSD для редагування та експортуйте у 

JPEG/PNG. 
 
Результати роботи завантажити на GoogleDrive і надати 

доступ kik_pvv@ztu.edu.ua 
 

mailto:kik_pvv@ztu.edu.ua


 

 

ПРАКТИЧНА РОБОТА №2 

Тема: Робота з шарами, масками та режимами 
накладання.  

Мета: Закріпити навички роботи з інтерфейсом графічно-
го редактора. Навчитися створювати растрові ілюстрації, 
використовуючи щітки та їх налаштування. Створювати 
композиції з тестовими парами.  

 
Теоретичний матеріал: 
 
https://helpx.adobe.com/ua/photoshop/kb/create-collages-
montages-photoshop-photoshop.html  

 
Завдання 1:  
Підготувати робочу область відповідно ваших потреб: 
-налаштувати одиниці вимірювання; 
-виставити лінійки; 
-налаштувати направляючі; 
-виставити режим інтерфейсу. 
 
Завдання 2: Створити ілюстрацію на тему "Технології 

майбутнього", використовуючи інструменти малювання у 
Photoshop. 

Вимоги: 
1. Відкрийте Photoshop і створіть новий документ (А4, 

300 dpi, RGB). 
2. Використовуючи інструменти "Pen Tool", "Brush Tool", 

"Shape Tools", "Eraser Tool", створіть ілюстрацію, що зобра-

https://helpx.adobe.com/ua/photoshop/kb/create-collages-montages-photoshop-photoshop.html
https://helpx.adobe.com/ua/photoshop/kb/create-collages-montages-photoshop-photoshop.html


жує футуристичний гаджет, архітектуру або транспорт май-
бутнього. 

3. Використовуйте наступні налаштування кистей: 
Основна кисть: М'яка кругла (Soft Round), Opacity 80%-

100%, Flow 50%-70%. 
Текстурна кисть: Chalk або Dry Brush для створення 

ефекту поверхні. 
Світлові ефекти: Airbrush Soft Round для імітації неоно-

вих підсвіток. 
4. Використовуйте градієнти, текстури та обведення для 

деталізації зображення. 
5. Оптимізуйте ілюстрацію для використання у веб-

дизайні (RGB, 72 dpi, PNG). 
6. Додайте короткий опис (2-3 речення) того, що зображе-

но. 
Результат: Фінальна ілюстрація має виглядати гар-

монійно та відповідати заданій тематиці. 
Завдання 3:  
Створити оригінальний текстовий ефект у Photoshop. 
Вимоги: 
1. Створіть новий документ (А4, 300 dpi, RGB). 
2. Виберіть цікаве слово або фразу (3-10 символів). 
3. Використовуйте інструменти для створення ефектного 

тексту: 
Градієнти 
Обведення (Stroke) 
Тінь (Drop Shadow) 
Деформацію тексту (Warp Text) 
Стилі шарів (Blending Options) 
Маски та Clipping Mask 



 

4. Додайте фон (текстурований або градієнтний). 
5. Збережіть у форматі .PSD та експортуйте у .PNG. 
Приклади: 

 
Рис. 1. Ефект тексту 



 
Рис. 2. Розсіювання тексту 

Результат: Збережений файл має містити оригінальний 
текстовий ефект, який виглядає професійно та естетично. 

 
Результати роботи завантажити на GoogleDrive і надати 

доступ kik_pvv@ztu.edu.ua 
 

mailto:kik_pvv@ztu.edu.ua


 

 

ПРАКТИЧНА РОБОТА №3 

Тема: Інструменти ретушування та корекція 
фотографій. 

Мета: Навчитися професійно використовувати ін-
струменти ретушування та корекції фотографій у 
Photoshop для створення якісних, реалістичних та худож-
ніх зображень. 

 
Теоретичний матеріал: 
 

https://adretouchstudio.com/my-skin-retouching-workflow-
explained/  
http://adretouchstudio.com/my-skin-retouching-workflow-
explained-part-2/  
 

Файли для виконнання практичної роботи: 
https://drive.google.com/drive/folders/1GmsYsHM0NLYyOdLmT
jJl6bhkunsqCnQk?usp=sharing  

 
Завдання 1: Підготувати робочу область відповідно ва-

ших потреб: 
-налаштувати одиниці вимірювання; 
-виставити лінійки; 
-налаштувати направляючі; 
-виставити режим інтерфейсу. 
 
Завдання 2:  
Професійна ретуш шкіри та видалення дефектів 
Інструменти: Healing Brush Tool, Spot Healing Brush 

Tool, Patch Tool, Clone Stamp Tool, Frequency Separation 
1. Відкрийте портрет із недоліками (плями, зморшки, 

нерівності шкіри, зайві об’єкти). 

https://adretouchstudio.com/my-skin-retouching-workflow-explained/
https://adretouchstudio.com/my-skin-retouching-workflow-explained/
http://adretouchstudio.com/my-skin-retouching-workflow-explained-part-2/
http://adretouchstudio.com/my-skin-retouching-workflow-explained-part-2/
https://drive.google.com/drive/folders/1GmsYsHM0NLYyOdLmTjJl6bhkunsqCnQk?usp=sharing
https://drive.google.com/drive/folders/1GmsYsHM0NLYyOdLmTjJl6bhkunsqCnQk?usp=sharing


2. Використовуйте Spot Healing Brush Tool для швидкого 
видалення дрібних дефектів. 

3. Healing Brush Tool та Patch Tool застосуйте для 
виправлення великих проблемних ділянок. 

4. Виконайте розділення частот (Frequency Separation) для 
збереження текстури шкіри та м’якого згладжування. 

5. Використовуйте Clone Stamp Tool для відновлення 
природних деталей. 

6. Збережіть проміжний результат у форматі .psd. 
 
Завдання 3:  
Глибока корекція кольору та тону 
Інструменти: Adjustment Layers (Curves, Levels, 

Hue/Saturation, Selective Color), Dodge & Burn Tool, Color 
Grading 

1. Відкрийте попередньо відредаговане зображення. 
2. Додайте коригувальний шар Curves для точного 

налаштування контрасту. 
3. Використовуйте Selective Color для точкового виправ-

лення відтінків (наприклад, вирівнювання тону шкіри, 
нейтралізація небажаних кольорів). 

4. Інструментами Dodge & Burn виконайте художнє під-
свічування та затемнення для покращення об’єму. 

5. Використайте техніку Color Grading (градація кольору) 
для створення кінематографічного ефекту. 

6. Збережіть оновлений варіант у .psd та .jpeg. 
Завдання 4:  
Глобальна корекція та художня обробка 
Інструменти: Filter Gallery, Camera Raw Filter, 

Gradient Maps, Smart Objects 
1. Відкрийте зображення з попередніх етапів. 
2. Перейдіть до Filter → Camera Raw Filter та вручну 

налаштуйте: 
o Баланс білого 



 

o Контраст 
o Чіткість 
o Колірний баланс 
o Ефект текстуризації 
3. Використайте Gradient Maps для стилізації кольорів, 

додаючи унікальний відтінок зображенню. 
4. Конвертуйте зображення у Smart Object для можли-

вості зворотного редагування. 
5. Додайте ефект Gaussian Blur або Tilt-Shift для худож-

нього розмиття заднього плану, залишаючи головний об’єкт у 
фокусі. 

6. Використовуйте High Pass Sharpening для деталізації 
важливих елементів (очі, губи, волосся). 

7. Збережіть фінальний результат у .jpeg та .psd. 
Завдання 5: 
Використовуючи інструменти: Layer Masks, Blend 

Modes, Transform, Filters, Adjustment Layers 
1. Виберіть два або більше зображень для поєднання у 

фінальний колаж. 
2. Використовуйте Layer Masks для акуратного поєднання 

елементів різних зображень. 
3. Налаштуйте Blend Modes для гармонійного поєднання 

шарів. 
4. Скористайтеся Transform (Ctrl+T) для правильного 

масштабу та перспективи. 
5. Додайте корекційні шари Curves, Hue/Saturation для 

узгодження кольорів. 
6. Використовуйте Filters для створення фінального ефек-

ту (наприклад, стилізація під ретро або фантастичний стиль). 
7. Збережіть фінальний результат у форматі .jpeg та .psd 
Результати роботи завантажити на GoogleDrive і надати 

доступ kik_pvv@ztu.edu.ua 
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ПРАКТИЧНА РОБОТА №4 

Тема: Робота з текстом та стилями шарів у Adobe 
Photoshop 

Мета: Опанувати основи та розширені прийоми робо-
ти з текстом у Photoshop, навчитися створювати креа-
тивні ефекти за допомогою стилів шарів, масок, фільтрів 
та змішування тексту з фоновими зображеннями. 

 
Теоретичний матеріал: 
https://www.adobe.com/creativecloud/photography/discover/n

eon-effect.html - ефект неону у фотошоп 
 
 

Завдання 1: 
 Постер із текстом і текстурою 
Створити графічний постер на основі цитати або власного 

гасла, використовуючи шрифти, стилі шару та накладення 
текстури. 
 Основний акцент — створення об'ємного ефекту тексту з за-
стосуванням стилів шару: тінь, тиснення, накладення 
градієнта або текстури. 
 Додатково можна додати геометричні елементи або декора-
тивне тло. 

https://www.adobe.com/creativecloud/photography/discover/neon-effect.html
https://www.adobe.com/creativecloud/photography/discover/neon-effect.html


 

 
Рис 3.  Приклад постеру з текстурою 

 
Завдання 2.  
Текст із ефектом світіння (неон, вогонь) 
Розробити яскраву композицію на темному фоні з тек-

стом, що імітує світловий ефект. 
 Можна обрати напрям: неонова вивіска, ефект полум’я, елек-
тричне сяйво тощо. 
 Застосовується зовнішнє світіння, дублювання шарів із роз-
миттям, додаткові ефекти за допомогою пензлів. 



 

 
Рис 4. Приклад тексту із ефектом світіння (неон, вогонь) 
 
Завдання 3.  
Створення ефекту поєднання тексту із зображенням 
Створити ефект, коли текст ніби є частиною об’єкта: 

напис на стіні, гравіювання на металі, тиснення на дереві 
тощо. 
 Потрібно накласти текст на фотографію, застосувати маски 
шару, стилі шару, корекцію зображення, прозорість, та інше.  



 

 
Рис 5. Приклад Тексту з ефектом 

 
Результат виконання: 
1. Три PSD-файли — по одному на кожне завдання. 
2. Експортовані зображення у форматі JPEG або PNG. 
Результати роботи завантажити на GoogleDrive і надати 

доступ kik_pvv@ztu.edu.ua 
 

mailto:kik_pvv@ztu.edu.ua


 

ПРАКТИЧНА РОБОТА №5 

Тема: Застосування фільтрів у Photoshop 
 

 Мета: Засвоїти принципи роботи з фільтрами 
Adobe Photoshop, навчитися створювати складні візуальні 
ефекти шляхом комбінування кількох фільтрів, створення 
нестандартних текстур та модифікації зображення. 

Завдання 1:  
Створення ефекту подвійної експозиції 
1. Візьміть портретне фото (власне або зі стоків). 
2. Додайте друге зображення — пейзаж або архітектуру. 
3. За допомогою фільтрів Blur, Gaussian Blur, Smart 

Filters та режимів накладення створіть ефект подвійної експо-
зиції. 

4. Використовуйте маски та коригувальні шари для 
тонкої настройки прозорості та балансу. 

5. Збережіть роботу у форматі .psd та .jpg. 
 
 



 

 
Рис 6. Ефект подвійної експозиції 

Завдання 2:  
Створення текстурованого постера з художнім ефек-

том 
1. Виберіть будь-яке зображення (наприклад, обличчя, 

рука, тварина). 
2. Створіть ефект  художньої обробки за допомогою 

фільтрів: 
o Filter Gallery  
3. Додайте текстури (граніт, папір, метал) через фільтри 

Texturizer або накладання зовнішніх зображень. 
 
 



4. Створіть постер формату A4 з дизайнерським оформ-
ленням (шрифт, заголовок, композиція). 

Приклад: 

 
Рис 7. Рисунок з текстурою 

Завдання 3:  
Стилізація фото під ілюстрацію / цифровий живопис 
Крок 1: Вибір зображення 
Виберіть якісне фото (портрет або архітектуру/пейзаж). 

 
 



 

Крок 2: Попередня обробка 
Застосуйте Filter для налаштування світла, тіней, кон-

трасту. 
За бажанням зробіть ретуш (Clone Stamp, Healing Brush). 
Крок 3: Перетворення у "цифровий 

малюнок" 
Створіть копію шару та застосуйте до неї фільтр Filter → 

Filter Gallery → Cutout (налаштуйте до ефекту пласких коль-
орових площин). 

Додайте ще один шар зверху і застосуйте фільтр Dry 
Brush або Poster Edges. 

Комбінуйте результати за допомогою режимів накладання 
(Overlay, Soft Light, Multiply) і масок. 

Крок 4: Деталізація 
Намалюйте вручну деякі елементи (наприклад, очі, конту-

ри обличчя) за допомогою Brush Tool. 
Додайте текстуру полотна або паперу (через шар з режи-

мом накладання та фільтром Texturizer). 
Крок 5: Фінальні ефекти 
Додайте легкий Noise, Sharpen або Vignette, щоб зібрати 

композицію. 
За бажанням — фільтр Oil Paint (плавний painterly-ефект). 

Результати роботи завантажити на GoogleDrive і 
надати доступ kik_pvv@ztu.edu.ua 
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ПРАКТИЧНА РОБОТА № 6 

Тема: Поєднання векторної і растрової графіки у 
Photoshop 

Мета: Навчитися комбінувати векторні та растрові 
елементи у графічних композиціях, використовуючи 
інструменти та фільтри Photoshop для створення 
стилізованих зображень, дизайнерських макетів та 
обкладинок. 

Завдання 1: 
Перетворення зображення у векторний стилізований 

малюнок 
Інструкція: 
1. Відкрийте обране фотографічне зображення у 

Photoshop. 
2. Зробіть дублікат шару з вихідним зображенням. 
3. Застосуйте до дубліката фільтр: 
Filter → Filter Gallery → Cutout (підберіть параметри так, 

щоб зображення виглядало як плаский малюнок з кількома 
рівнями кольору). 

4. Для посилення контурів застосуйте фільтр: 
Filter → Stylize → Find Edges, а потім інвертуйте кольори (Ctrl 
+ I) і встановіть режим накладання шару на Multiply. 

5. За потреби використайте інструмент Pen Tool для 
вручну підсилення чи виправлення контурів. 

6. Збережіть фінальний результат у форматі .PSD та .JPG. 
Результат: Стилізований малюнок з пласкими кольорами 

та чіткими лініями, який імітує векторний арт. 



 

 
Рис 8. Векторизація зображення 



Завдання 2: 
Комбінування фільтрів, векторних об’єктів і 

растрового зображення 
Інструкція: 
1. Відкрийте основне растрове зображення (наприклад, 

портрет чи пейзаж). 
2. Застосуйте до нього художній фільтр, наприклад: 
Filter → Filter Gallery → Poster Edges або Oil Paint. 
3. Створіть векторні об’єкти: 
Використайте Pen Tool (P) або Custom Shape Tool для 

створення геометричних форм, контурів або декоративних 
елементів. 

Задайте їм заливку, обводку і накладання тіней через 
Layer Styles. 

4. Додайте текстові написи (вони теж будуть векторними) 
з використанням інструмента Type Tool. 

5. Розташуйте всі елементи на окремих шарах та скомпо-
нуйте їх у гармонійну композицію. 

6. За потреби використовуйте маски шарів для плавного 
поєднання растрових і векторних елементів. 

7. Збережіть роботу у форматі .PSD та зробіть експорт у 
.JPG або .PNG для демонстрації. 

Результат: Єдина композиція, яка містить стилізоване 
зображення, векторні форми та текст, оформлені як сучасний 
постер чи арт-робота. 



 

 
Рис 9. Постер 

Завдання 3: 
Створення обкладинки для журналу (формат А4) 
Інструкція: 
1. Створіть новий документ у Photoshop: 
File → New → Встановіть розмір: 210 х 297 мм (формат 

А4), роздільна здатність — 300 dpi, колірний режим — 
CMYK або RGB (якщо для вебу). 
 
 



2. Додайте основне зображення для фону або централь-
ного акценту (це може бути фото чи стилізована ілюстрація з 
попередніх завдань). 

3. Розмістіть заголовок журналу у верхній частині об-
кладинки: 

Використовуйте великий шрифт та яскравий колір. 
Надайте тексту ефекти (Layer Styles), наприклад, тінь або 

обвідку. 
4. Додайте другорядні написи (назви статей, номери 

випуску, дату тощо) з використанням різних шрифтів і роз-
мірів для створення ієрархії. 

5. Додайте векторні елементи або декоративні лінії для 
акцентів. 

6. За потреби використовуйте фільтри або градієнтні за-
ливки для глибини та динаміки фону. 

7. Додайте штрихкод у нижній частині (можна знайти 
безкоштовний PNG в Інтернеті). 

8. Перевірте поля та візуальну рівновагу елементів. 
9. Збережіть фінальну версію у форматах .PSD і .JPG (або 

.PDF для друку). 
Результат: Повноцінна обкладинка журналу формату А4 

з заголовком, графікою, текстом і декоративними елементами. 
 



 

 
Рис 10. Приклад постеру 

Результати роботи завантажити на GoogleDrive і 
надати доступ kik_pvv@ztu.edu.ua 

 
 
 

 

mailto:kik_pvv@ztu.edu.ua


 

ПРАКТИЧНА РОБОТА № 7 

Тема: Створення дизайнерської композиції на основі 
комбінування векторної та растрової графіки. 

Мета: Закріпити навички обробки зображень у 
Photoshop, поєднуючи растрові фото, векторні елементи, 
шари, маски, фільтри та ефекти. Розвивати вміння 
працювати з композицією, кольором, типографікою та 
графічним стилем. 

 
Завдання 1: 
Арт-колаж: “Я в іншій реальності” 
Мета: Створити сюрреалістичну або стилізовану 

композицію, використовуючи фотоманіпуляції, фільтри та 
векторні вставки. 

Інструкція: 
1. Виберіть власне фото або зображення людини в 

хорошій якості. 
2. Виріжте об’єкт за допомогою Select Subject / Object 

Selection Tool і помістіть його на новий фон. 
3. Додайте до сцени щонайменше 3 різних растрових 

елементи (небо, ліс, будівлі тощо) та 2 векторні об’єкти 
(наприклад, геометричні форми, іконки, лінії). 

4. Застосуйте маски, режими накладання та фільтри 
(наприклад, Gaussian Blur, Color Lookup, Gradient Map) для 
стилізації композиції. 
 
 



 

5. Додайте заголовок або короткий текст у відповідному 
стилі. 

6. Завершіть композицію корекцією кольору (через 
Adjustment Layers). 

Результат: Колаж із виразною візуальною ідеєю, 
поєднанням стилів і чіткою композицією. 

 
Завдання 2: 
Авторський постер на тему за вибором 
Мета: Створити унікальний графічний постер, що містить 

як векторні, так і растрові елементи. 
Вимоги до постера: 
Формат: А3 (297×420 мм) або А4 (210×297 мм), 300 dpi, 

RGB або CMYK. 
Тематика: на вибір студента (соціальна реклама, фільм, 

концерт, книга, виставка тощо). 
Має містити: 
Один або кілька растрових зображень, стилізованих 

фільтрами або ручною обробкою; 
Векторні елементи (фігури, лінії, графіка); 

Типографіку — заголовок, підзаголовок, інформаційний 
текст; 
Баланс композиції та кольорів. 

Результати роботи завантажити на GoogleDrive і 
надати доступ kik_pvv@ztu.edu.ua 
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